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CE-SDS Protein Analysis Kit 1
The CE-SDS Protein Analysis Kit provides the reagents and supplies to resolve both reduced
and non-reduced proteins by size, and to quantify the heterogeneity and impurities that might
exist in a protein preparation.

This document provides instructions for sample preparation with the CE-SDS Protein Analysis
Kit. It also provides instructions for data acquisition with the BioPhase software and the Waters
Empower™ software with the BioPhase 8800 driver for Empower™. This document also provides
instructions for analysis of data acquired with BioPhase software. Analysis of data acquired with
the Waters Empower™ software must be done using the Waters Empower™ software.

Use the information in this application guide as a starting point. As required, change injection
time, voltage, injection type, or other parameters to find the best conditions for your needs.

Note: For instructions for safe use of the system, refer to the document: Operator Guide.

Safety
Refer to the safety data sheets (SDSs), available at sciex.com/tech-regulatory, for information
about the proper handling of materials and reagents. Always follow standard laboratory safety
guidelines. For hazardous substance information, refer to the section: Hazardous Substance
Information.

Intended Use
The CE-SDS Protein Analysis kit is for laboratory use only.

Introduction
The CE-SDS Protein Analysis Kit includes reagents to resolve both reduced and non-reduced
proteins by size, and to quantify the heterogeneity and impurities that might exist in the protein.
The methodology involves heat denaturation of a specified concentration of protein in the
presence of sodium dodecyl sulfate (SDS). Once denatured, the sample is separated by size
in a capillary containing a replaceable SDS polymer matrix, which provides the sieving selectivity
for the separation.

Workflow
The workflow consists of the following steps:

1. Determine the number of samples to be analyzed and the number of replicates.

CE-SDS Protein Analysis Kit
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2. For BioPhase software users:

a. Create or modify the methods. Refer to the section: Methods.

b. Create the sequence and the sample and reagent plate layouts. Refer to the section:
Create the Sequence.

3. For Waters Empower™ software users:

a. Import BioPhase software methods. Refer to the section: Import the BioPhase Software
Methods to Create the Instrument Methods.

b. Create the sample set methods and the sample and reagent plate layouts. Refer to the
section: Create the Sample Set Method.

4. Prepare the samples. Refer to the section: Prepare the Samples.

There are two separate workflows, reduced and non-reduced.

5. Use the sample and reagent plate layouts to prepare the plates.

6. Put the plates in the BioPhase 8800 system. Refer to the sections: Load the Sample Inlet
and Outlet Plates and Load the Reagent Inlet and Outlet Plates.

7. Start data acquisition.

• (BioPhase software) Start the sequence from the front panel. Refer to the section: Run
the Samples.

• (Waters Empower™ software) Start the sample set method from the Waters Empower™

software with the BioPhase 8800 driver for Empower™. Refer to the section: Start the
Sample Set Method.

8. Analyze the data.

• (BioPhase software) When the sequence is complete, analyze the data with the
BioPhase Analysis software. Refer to the section: Analyze the Data.

• (Waters Empower™ software) When the sample set method is complete, analyze the data
with the Waters Empower™ software. For data analysis instructions, refer to the Waters
Empower™ software guides and help file.

CE-SDS Protein Analysis Kit
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Required Equipment and Materials 2
Note: For items with a reorder part number, sometimes the reorder quantity is different than the
quantity in the kit.

Table 2-1 CE-SDS Protein Analysis Kit (PN C30085)

Component Quantity Reorder Part
Number

10 kDa Internal Standard 2 A26487

Acid Wash/Regenerating Solution (100 mL) 1 N/A

Capillary Regenerator Solution A Basic Wash (100 mL) 1 N/A

CE Grade Water (140 mL) 3 C48034

CE-SDS Gel Buffer (140 mL) 2 A30341

Low pH SDS Sample Buffer (55 mL) 1 C44807

SDS-MW Sample Buffer 1 N/A

Table 2-2 Additional Supplies from SCIEX

Component Quantity Part Number

(Optional) Low pH Phosphate SDS Sample Buffer (40 mM
Phosphate, pH 6.5, 1% SDS) (140 mL)

1 C57805

Capillary cartridge coolant (450 mL) 1 359976

IgG Control Standard (1 mg/mL) (1 mL) 3 391734

MW Size Standard (sizing ladder containing 10 kDa,
20 kDa, 35 kDa, 50 kDa, 100 kDa, 150 kDa, and 225 kDa
proteins) (100 µL)

3 A22196

BioPhase 8800 bare fused-silica capillary cartridge
(50 µm i.d. × 30 cm capillaries)

1 5080121

BioPhase 8800 outlet plates 20 5080315

BioPhase 8800 reagent plates 20 5080314

BioPhase 8800 sample plates 20 5080313

Required Equipment and Materials
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Table 2-2 Additional Supplies from SCIEX (continued)

Component Quantity Part Number

BioPhase 8800 Starter Plate Pack (4 sample plates, 4
reagent plates, 8 outlet plates)

1 5080311

Table 2-3 Additional Required Reagents or Supplies

Description Vendor Part Number

(Optional) Amicon Ultra-4 Centrifugal Filter Unit with
Ultracel-10 membrane

MilliporeSigma UFC801024

(Optional) MicroCon-10 kDa Centrifugal Filter Unit with
Ultracel-10 membrane

MilliporeSigma MRCPRT010

(Optional) MicroCon-30 kDa Centrifugal Filter Unit with
Ultracel-30 membrane

MilliporeSigma MRCF0R030

2-mercaptoethanol MilliporeSigma M7154

Iodoacetamide MilliporeSigma I-1149

X-Pierce Film USA Scientific 2997-0100

Storage Conditions
Note: For storage conditions for prepared reagents, refer to the preparation instructions.

• Upon receipt, store the 10 kDa Internal Standard at 2 °C to 8 °C.

• Store the remainder of the kit contents at room temperature.

Customer-Supplied Equipment and Supplies
• Powder-free gloves, neoprene or nitrile recommended

• Safety glasses

• Laboratory coat

• Appropriate centrifuge

• Microcentrifuge, or equivalent, and microcentrifuge tubes

• Vortex mixer

• Pipettes and appropriate tips

For reagent plate preparation a repeater pipette or equivalent is recommended.

Required Equipment and Materials
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• Parafilm

• Centrifuge with swinging-bucket rotor to hold plates

• Water bath or heat block capable of 37 °C to 100 °C temperature

• Analytical balance

• Spatula

Required Detector
A UV detector equipped with a 220 nm filter is required.

Required Cartridge
CAUTION: Potential Wrong Result. If a cartridge is used with the CE-SDS Protein Analysis
kit, then do not use the same cartridge for another application. If the same cartridge
with different buffers and sample types is being used, then sample carryover, nonspecific
binding, and poor separation can occur.

A BioPhase 8800 BFS capillary cartridge with 50 µm i.d. × 30 cm capillaries is required.

Refer to the table: Table 2-2.

Required Equipment and Materials

CE-SDS Protein Analysis Kit For the BioPhase 8800
System
10/90

Application Guide
RUO-IDV-05-8662-D



Methods and Sequences 3
For Systems That Use the BioPhase Software

Note: If the validated methods and sequences are not included with the software, then they are
available for download from the SCIEX web site. Refer to the section: Download and Configure
the Required Files (BioPhase Software). The methods can also be created manually with the
BioPhase software. Refer to the section: Methods.

The following methods and sequence are required.

• CE-SDS Conditioning: Conditions the capillaries.

• Separation methods:

• Reduced CE-SDS Separation: For reduced samples.

• Non Reduced CE-SDS Separation: For non-reduced samples.

• Low pH Sample Buffer Separation: For samples prepared with a low pH sample buffer.

• CE-SDS Shutdown: Cleans the capillaries at the end of a sequence, rinses the capillaries for
storage, and then turns off the lamp.

• Sequence templates:

• Reduced CE-SDS Separation: For reduced samples.

• Non Reduced CE-SDS Separation: For non-reduced samples.

• Low pH Sample Buffer Separation: For samples prepared with a low pH sample buffer.

For Systems That Use the Waters Empower™ Software

Create the required instrument methods by importing the BioPhase software methods.

Note: If the methods are not included with the software, then they are available for download
from the SCIEX web site. Refer to the section: Download and Configure the Required Files
(Waters Empower™ Software). The methods can also be created manually with the Method
Editors for BioPhase System software. Refer to the section: Methods.

Create the Sequence
Note: If the Waters Empower™ software will be used to acquire the data, this procedure does not
apply. Refer to the section: Create the Sample Set Method.

Methods and Sequences
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Note: This procedure assumes familiarity with the BioPhase software. For detailed instructions,
refer to the document: Software Help System.

This procedure gives instructions for creating a sequence with a template supplied with the
BioPhase software. The template is set up for eight samples in the first column, and uses the
validated methods supplied with the software.

Sequences can also be created without a template. In most cases, a sequence should start
with a conditioning method, followed by separation methods, and then ending with a shutdown
method. The shutdown method should be assigned as the error recovery method. Refer to the
document: Software Help System.

Note: If the sequence includes replicate samples, then make that sure the replicates are in the
same row of the sample plate to decrease any capillary-to-capillary variation.

1. On the Home page of the BioPhase software, click Sequence Editor.

2. Click Open Sequence.
The Open a Sequence dialog opens.

3. Search for, and then select the appropriate sequence:

a. (Optional) Type a Start Date and End Date for the search or click the calendar icons,
select the dates, and then click Search.
The available project folders are shown in the Folder Name pane.

b. Click the CE-SDS Project project folder.
The available sequences in the project are shown in the table to the right.

c. In the table, click the appropriate sequence template and then click Open.

• For reduced samples, click CE-SDS Test Sequence.

• For non-reduced samples, click Non Reduced CE-SDS Sequence.

• For samples prepared with a low pH sample buffer, click Low pH Sample Buffer
CE-SDS Sequence.

The Open a Sequence dialog closes, and then the Sequence Summary tab opens.

4. Above the Sequence Summary pane, click Edit.
The Sample Plate Setup tab opens.

5. If required, do any of the following:

• Add or remove samples.

• Clear a method assigned to a sample well.

• Assign a different method to a sample well.

• In the Sequence Summary table, assign the recovery method to a method in the
sequence. Typically, the shutdown method should be assigned as the recovery method.

Methods and Sequences
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For detailed instructions, refer to the document: Software Help System.

6. If required, edit the information in the Sequence Summary table.

Note: The method names are different for each sequence.

Figure 3-1 Sequence Summary Table: CE-SDS Test Sequence

7. To view details of a run, click the + in the row with the run.

Figure 3-2 Sequence Summary Table Expanded

8. If required, change the information in the Sample Id and Data File columns.

9. To view the sample plate and reagent plate layouts, open the Plates Layout tab. If required,
change the reagent locations in the Reagent Plate.

Methods and Sequences
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10. To save the sequence, click SAVE, and then add the required information.

Note: The SAVE button is not available if there are errors. Resolve all of the errors in the
Validation pane, and then click SAVE.

11. (Optional) To print the sample plate and reagent plate layouts, do the following:

a. Click PRINT.
The Print Preview dialog opens.

b. Click Plate Layout Report, and then click Print.

c. Select the printing options, and then click OK.
The report is printed.

d. Click the close box, the × in the top right corner.
The Print Preview dialog closes.

Methods and Sequences
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Prepare the Samples 4
The comparison of the reduced and the non-reduced states of a protein can supply important
structural information. This section includes instructions to prepare reduced and non-reduced
standards and samples.

Prepare a Standard
Depending on the goal of the analysis, different standards might be appropriate. Use a standard
that is appropriate for the analysis.

Prepare the Reduced MW Size Standard
This standard is prepared under reducing conditions to break or prevent any protein aggregation
formed by disulfide bridges.

Note: The following instructions give quantities for one sample.

1. Mix the MW Size Standard thoroughly, and then spin the vial for a few seconds in a
standard microcentrifuge.

2. Add 10 µL of the MW Size Standard to a 0.5 mL microcentrifuge tube.

3. Add 85 µL of the SDS-MW Sample Buffer to the microcentrifuge tube.

4. Add 2 µL of the 10 kDa Internal Standard to the microcentrifuge tube.

5. Add 5 µL of 2-mercaptoethanol to the microcentrifuge tube inside a fume hood.

6. Secure the vial cap with Parafilm, mix thoroughly using a vortex mixer, and then heat the
mixture in a water bath at 70 °C for 10 min.

7. Spin the tube in a centrifuge for 1 min at 300 g.

8. Remove the vial from the water bath and let it sit for a minimum of 3 min to cool the solution
to room temperature.
The standard stays stable for approximately 24 hours.

9. Add 100 µL of the prepared standard to the sample plate well.
Make sure that, for any column on the sample plate with sample, the corresponding column
on the outlet plate has 2.0 mL of CE-SDS Gel Buffer.

10. Put a film cover on the plate, and then use a centrifuge to spin the sample plate for 4 min at
30 g to remove any bubbles at the bottom of the wells.

Prepare the Samples
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Prepare the IgG Control Standard
For analysis of immunoglobulin preparations, the SCIEX IgG Control Standard can be used as a
standard. The standard can be prepared under reducing or non-reducing conditions.

Prepare the Reduced IgG Control Standard

Note: The following instructions give quantities for one sample.

1. Prepare the IgG Control Standard.

a. For the initial run, remove one vial of IgG Control Standard from the freezer and let it
thaw completely at room temperature.

b. Mix briefly for a few seconds with a vortex mixer and then aliquot the solution in 95 μL
portions.

c. Reserve one aliquot and then store the remaining aliquots at –35 °C to –15 °C.

2. Use one of the 95 μL aliquots of the IgG Control Standard. If it is frozen, then thaw it at room
temperature before use.

3. Add 2 µL of the 10 kDa Internal Standard to the IgG vial.

4. Add 5 µL of 2-mercaptoethanol to the IgG vial inside a fume hood.

5. Secure the vial with the vial cap and then mix it thoroughly using a vortex mixer.

6. Spin the vial using a centrifuge for 1 min at 300 g.

7. Secure the vial cap with Parafilm and then heat the mixture in a water bath at 70 °C for
10 min.

8. Remove the vial from the water bath, and then let it sit for a minimum of 3 min to cool the
solution to room temperature.

9. Add 100 µL of the prepared standard to the sample plate well.

10. Put a film cover on the plate, and then use a centrifuge to spin the sample plate for 4 min at
30 g to remove any bubbles at the bottom of the wells.

Prepare the Non-Reduced IgG Control Standard
Before preparing the non-reduced IgG Control Standard, prepare a 250 mM iodoacetamide
(IAM) solution. Refer to the section: Prepare the 250 mM Iodoacetamide Solution.

Prepare the 250 mM Iodoacetamide Solution

1. Weigh 46 mg of iodoacetamide (IAM) and add it to a 1.5 mL microcentrifuge vial.

2. Add 1 mL of CE Grade Water to make a solution that is 46 mg/mL.

3. Seal the vial with a cap and then mix the solution until the solids dissolve fully.

Prepare the Samples
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4. When it is not in use, keep the solution in the dark.
The iodacetamide solution is stable for approximately 24 hours at room temperature.

Prepare the Non-reduced IgG Control Standard

Note: The following instructions give quantities for one sample.

1. Prepare the IgG Control Standard.

a. For the initial run, remove one vial of IgG Control Standard from the freezer and let it
thaw completely at room temperature.

b. Mix briefly for a few seconds with a vortex mixer and then aliquot the solution in 95 μL
portions.

c. Reserve one aliquot and then store the remaining aliquots at –35 °C to –15 °C.

2. Use one of the 95 μL aliquots of the IgG Control Standard. If it is frozen, then thaw it at room
temperature before use.

3. Add 2 µL of 10 kDa Internal Standard to the IgG Control Standard tube.

4. Add 5 µL of 250 mM IAM solution.

5. Secure the vial with a cap and then mix thoroughly using a vortex mixer.

6. Spin the vial in a centrifuge for 1 min at 300 g.

7. Secure the vial cap with Parafilm and then heat the mixture in a water bath at 70 °C for
10 min.

8. Remove the vial from the water bath, and then let it sit for a minimum of 3 min to cool the
solution to room temperature.

The standard remains stable for approximately 24 hours.

9. Mix the solution in the vial and then spin the vial in a centrifuge for 1 min at 300 g.

10. Add 100 µL of the prepared standard to the sample plate.
Make sure that, for any column on the sample plate with sample, the corresponding column
on the outlet plate has 2.0 mL of CE-SDS Gel Buffer.

11. Put a film cover on the plate, and then use a centrifuge to spin the sample plate for 4 min at
30 g to remove any bubbles at the bottom of the wells.

Prepare the Samples
Use the following procedure to prepare one sample.

Recommended Protein Concentration
After the SDS-MW Sample Buffer is added, the total protein concentration must be between
0.2 mg/mL and 2 mg/mL. For best results, the recommended protein concentration is 1 mg/mL.

Prepare the Samples
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If the protein concentration is too high, then insufficient SDS binding might result, causing broad
peaks and poor resolution. If the protein concentration is too low, a low signal may occur.

The signal intensity and resolution of this assay are also sensitive to the salt concentration in the
protein sample. If the salt concentration is too high, then low signal and peak tailing is likely to
occur. Refer to the section: Do a Buffer Exchange for the Protein Sample.

Prepare the Reduced Samples
Note: The following instructions give quantities for one sample.

1. Dilute the sample with the SDS-MW Sample Buffer to a volume of 95 µL to give a final
protein concentration between 0.2 mg/mL to 2 mg/mL.

Note: Make sure that no more than 45 µL of the sample is added to the SDS-MW sample
buffer. If more than 45 µL is required, then concentrate the sample before diluting it with
buffer.

2. Add 2 µL of 10 kDa Internal Standard to the sample microcentrifuge tube.

3. Inside the fume hood, add 5 µL of 2-mercaptoethanol to the microcentrifuge tube.

4. Secure the microcentrifuge tube cap and then mix it thoroughly using a vortex mixer.

5. Use a centrifuge to spin the tube for 1 min at 300 g.

6. Seal the vial cap with Parafilm, and then heat at 70 °C for 10 min.

Note: If the protein is stable at high temperatures, then it can be heated at 100 °C for 3 min
instead.

7. Remove the vial from the water bath, and then let it sit for a minimum of 3 min to cool the
solution to room temperature.

8. Mix the sample tube, and then spin using a centrifuge for 1 min at 300 g.

9. Add 100 µL of the prepared sample to the sample plate.
Make sure that, for any column on the sample plate with sample, the corresponding column
on the outlet plate has 2.0 mL of CE-SDS Gel Buffer.

10. Put a film cover on the plate, and then use a centrifuge to spin the sample plate for 4 min at
30 g to remove any bubbles at the bottom of the wells.

Prepare the Non-reduced Samples
Before the non-reduced sample is prepared, prepare a 250 mM iodoacetamide (IAM) solution.
Refer to the section: Prepare the 250 mM Iodoacetamide Solution. The IAM solution operates
as the alkylating agent during preparation of the sample to decrease any heterogeneity that is
created from the partial auto-reduction of the protein.

Prepare the Samples
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For non-reducing conditions, the sample solution must be heated at a high temperature to
increase SDS binding. However, high temperatures might cause fragmentation and aggregation,
which can result in artifacts in the sample analysis. SCIEX recommends that this alkylation
step be done to minimize temperature-induced artifacts in the protein sample. SCIEX also
recommends the use of one of the low pH SDS sample buffers for non-reduced samples. The
Low pH Phosphate SDS Sample Buffer has been proven to decrease heat-induced artifacts
more than the SDS-MW Sample Buffer.

Note: The following instructions give quantities for one sample.

1. Dilute the sample with the SDS-MW Sample Buffer to a volume of 95 µL to give a final
protein concentration between 0.2 mg/mL to 2 mg/mL.

Note: Make sure that no more than 45 µL of the sample is added to the SDS-MW sample
buffer. If more than 45 µL is required, then concentrate the sample before diluting it with
buffer.

2. Add 2 µL of the 10 kDa Internal Standard to the sample microcentrifuge tube.

3. Inside a fume hood, add 5 µL of the 250 mM IAM solution to the sample tube.

4. Use a centrifuge to spin the vial for 1 min at 300 g.

5. Seal the vial with Parafilm.

6. Heat the mixture in a water bath at 70 °C for 10 min.

7. Remove the vial from the water bath, and then let it sit for a minimum of 3 min to cool the
solution to room temperature.

8. Add 100 µL of the prepared sample to the sample plate.
Make sure that, for any column on the sample plate with sample, the corresponding column
on the outlet plate has 2.0 mL of CE-SDS Gel Buffer.

9. Put a film cover on the plate, and then use a centrifuge to spin the sample plate for 4 min at
30 g to remove any bubbles at the bottom of the wells.

Do a Buffer Exchange for the Protein Sample
The signal intensity and resolution of this assay is sensitive to the salt concentration in the
protein sample. If the salt concentration is above 1× phosphate buffered saline (PBS), then low
signal and peak tailing might occur. Use the steps in this procedure to do a buffer exchange.

Note: For desalting or buffer exchange procedures that use a device from another manufacturer,
refer to the manufacturer User Guide.

Note: For IgG samples, do not use a MicroCon-30kDa filter because it can filter out the free light
chain (25 kDa) in the IgG sample, resulting in biased or inaccurate purity results.

Prepare the Samples
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1. Add 1 mL of protein sample to the appropriate centrifugal filter unit.

• For IgG samples, use an Microcon-10kDa centrifugal filter unit.

• For other proteins, use an Amicon Ultra-4 centrifugal filter unit.

2. Use a centrifuge to spin the sample for 15 min at 4,000 g.

3. Add 2 mL of SDS-MW Sample Buffer, and then use a centrifuge to spin the sample for
25 min at 4,000 g.

4. Carefully put the centrifugal filter unit in a new vial in an inverted position, and then use a
centrifuge to spin the vial for 3 min at 1,000 g.
The protein solution is collected in the vial.

5. Transfer the collected protein solution to an appropriate tube.

6. Determine the protein concentration.

7. Add the SDS-MW Sample Buffer to a final concentration of 1 mL.

Using a Low pH Sample Buffer
Note: SCIEX carries two different low pH sample buffers, the Low pH SDS Sample Buffer (Tris,
pH 6.8) (included in the CE-SDS Protein Analysis Kit) and the optional Low pH Phosphate SDS
Sample Buffer (pH 6.5).

Some samples are more stable in a sample buffer with a lower pH. If the separation profile
changes with each repetition, then the protein may not be stable in SDS-MW Sample Buffer,
which is pH 9. Prepare the sample again using a low pH buffer.

To use either of the low pH sample buffers, prepare the samples as described previously, but
replace the SDS-MW Sample Buffer with either the Low pH SDS Sample Buffer (pH 6.8) or Low
pH Phosphate SDS Sample Buffer (pH 6.5).

Because the low pH buffers have increased ionic strength, we recommend changing the
separation method by increasing the injection voltage or duration to prevent any signal loss.
Adjust the separation time based on the samples to be analyzed. Alternatively, use a pressure
injection in the separation method.

Prepare the Samples
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Prepare the BioPhase 8800 System 5
Use the procedures in this section to prepare the BioPhase 8800 system to acquire data.

The procedures in this section assume that the system has already been properly installed and
initialized.

Tip! To save time, turn on the light source 30 minutes before starting the run so it can warm up.

Load the Reagent Inlet and Outlet Plates
Note: To prevent air bubbles, do not shake or vigorously mix the gel buffer. Air bubbles might
cause issues with the separation.

1. Add the reagents to the reagent inlet and outlet plates according to the reagent plate layout.
Refer to the figure: Figure D-4.

Use the volumes in the following table.

Note: For the outlet plate, make sure that the chamfered corner is on the upper right, and
then fill only the wells on the left side of the plate. The wells on the right side are for overflow
and must be empty.

Table 5-1 Reagents for the Reagent Inlet and Outlet Plates

Plate Reagent

Inlet plate 800 µL per well

Outlet plate • 2.8 mL per well of reagent for separation or wait actions

• 1.5 mL per well of CE Grade Water for waste positions

2. Put a film cover on the plates.

CAUTION: Potential System Damage. Do not use a heated plate sealer to apply the
seal. The heat might damage the surface of the plates, which might cause issues with
the pressure system.

Note: Only X-Pierce film from USA Scientific is validated. If a different film is used, then test
it before use.
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3. Put the plates in a swinging-bucket rotor, and then spin them for 4 min at 30 g. Make sure
that the buckets are balanced.

CAUTION: Potential Wrong Result. Do not load the plates in the system without
spinning them to remove air bubbles. The presence of air bubbles might cause the
separation to fail.

4. Make sure that there are no air bubbles present in the plates. If air bubbles are present,
then spin the plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 g. For the sample plate, the maximum
RCF is 375 g.

5. On the front panel, touch Eject Reagent.

Figure 5-1 Eject Reagent Button

The plate compartment opens.

6. Remove the film cover from the plates.

CAUTION: Potential System Damage. Do not load plates in the system before
removing the film cover. The presence of the film cover during a run might damage
the capillary tips.

7. If the plate compartment already contains reagent plates, then remove the reagent plates.

8. Align the notch in the reagent inlet plate with the tab, and then put the plate in the plate
carrier.

9. Make sure that the chamfered corner of the reagent outlet plate is in the top left, and then
put the plate in the back of the plate carrier.

10. Touch Load Reagent.

Figure 5-2 Load Reagent Button

The plate compartment closes.

Prepare the BioPhase 8800 System
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Load the Sample Inlet and Outlet Plates
1. Add the samples to the sample inlet plate according to the sample plate layout. Refer to the

figure: Figure D-3.
The recommended sample volume is 100 µL.

The minimum sample volume is 50 µL. The maximum sample volume is 200 µL.

2. To prevent damage to the capillary, if there are columns where not every well has sample,
then add between 100 µL and 200 μL of sample buffer to each empty well.
If a column has no samples, then the wells can be left empty.

3. Add the reagents to the sample outlet plate according to the sample plate layout. Refer to
the figure: Figure D-3.
The maximum volume is 2.0 mL.

Use the volume in the following table.

Make sure that, for any column on the sample plate with sample, the corresponding column
on the outlet plate has 2.0 mL of separation gel.

Note: For the outlet plate, make sure that the chamfered corner is on the upper right, and
then fill only the wells on the left side of the plate. The wells on the right side are for overflow
and must be empty.

Table 5-2 Reagents for the Sample Outlet Plate

Plate Reagent

Outlet plate • 2.0 mL of gel buffer per well

4. Put a film cover on the plates.

CAUTION: Potential System Damage. Do not use a heated plate sealer to apply the
seal. The heat might damage the surface of the plates, which might cause issues with
the pressure system.

Note: Only X-Pierce film from USA Scientific is validated. If a different film is used, then test
it before use.

5. Put the plates in a swinging-bucket rotor, and then spin them for 4 min at 30 g. Make sure
that the buckets are balanced.

CAUTION: Potential Wrong Result. Do not load the plates in the system without
spinning them to remove air bubbles. The presence of air bubbles might cause the
separation to fail.
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6. Make sure that there are no air bubbles present in the plates. If air bubbles are present,
then spin the plates again at a higher relative centrifugal force (RCF).
For the reagent plate, the maximum RCF is 1,000 g. For the sample plate, the maximum
RCF is 375 g.

7. On the front panel, touch Eject Sample.

Figure 5-3 Eject Sample Button

The plate compartment opens.

8. Remove the film cover from the plates.

CAUTION: Potential System Damage. Do not load plates in the system before
removing the film cover. The presence of the film cover during a run might damage
the capillary tips.

9. If the plate compartment already contains sample plates, then remove the sample plates.

10. Orient the sample plate so that the alignment notch in the plate aligns with the tab, and then
put the plate in the plate carrier.

11. Orient the sample outlet plate so that the chamfered corner is in the upper left, and then put
the plate in the back of the plate carrier.

12. Touch Load Sample.

Figure 5-4 Load Sample Button

The plate compartment closes.

Examine the Capillary Cartridge
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.
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CAUTION: Potential System Damage. Do not let the gel buffer or other reagents
crystallize on the electrodes, capillary ends, cartridge seals, or cartridge body. Electrolyte
salt crystals or precipitate can cause plugged capillaries, improper pressure sealing,
errors when injecting samples, arcing, or current leakage.

1. Examine the electrodes, capillary tips, cartridge seals, and cartridge body interface before
use.

2. If there is gel or liquid on the outside of the cartridge, then clean the cartridge with a damp
lint-free laboratory wipe. After cleaning, make sure to dry the cartridge.

Note: Do not use soap or detergent to clean the cartridge.

3. If the capillary tips are blocked, then do this:

a. Use CE Grade Water to clean the capillary inlets.

b. Use a lint-free laboratory wipe to wipe the capillary inlets carefully in an outward
direction.

4. Use a magnifying glass to examine both sides of the capillary window. If lint or other
particles are present, then use short bursts of electronics-grade compressed air to remove
them. Do not use water or other liquids to clean the capillary window.

CAUTION: Potential System Damage. Do not use organic solvents, such as methanol
or acetone, to clean the capillary window. Organic solvents can dissolve the
adhesives, leaving residue on the capillary window that might interfere with the
detector.

5. Moisten a lint-free laboratory wipe or cotton swab with ethanol or isopropyl alcohol, and then
wipe the surface of the chip. Let the chip air dry before installing the cartridge.

Install the Cartridge
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

WARNING! Pinching Hazard. When opening the front panel, be careful not to put
fingers to the left of the front panel.

CAUTION: Potential System Damage. Make sure that the reagent plates are installed in
the system before installing the cartridge. Failure to do so might damage the cartridge.

1. If the cartridge was stored in the refrigerator, then let the cartridge equilibrate to room
temperature for approximately 30 min to prevent condensation in the system.

2. Remove the cartridge from the wetting tray.
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3. Use a disposable laboratory wipe to dry the cartridge body to prevent arcing.

4. Turn the bottom of the cartridge up.

5. Use a disposable lint-free laboratory wipe to very gently dry the area where the capillaries
and electrodes emerge from the cartridge. Do not disturb the seals.

Figure 5-5 Bottom of the Cartridge

Item Description

1 Outlet plate seal

2 Inlet plate seal

6. If the reagent plates are not installed in the system, then install them. Refer to the section:
Load the Reagent Inlet and Outlet Plates.

7. Open the front panel, and then put the cartridge in the system.

8. Close the front panel, and then touch EJECTED to lock the cartridge.

Prepare the BioPhase 8800 System
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Figure 5-6 EJECTED Button

If the cartridge run life has been exceeded, then a warning message is added to the front

panel log. To view the warning message, touch  on the front panel status area. The
cartridge can still be used or a new one can be installed.

The system moves the reagent plate so that the capillaries are in position over column 1,
and then raises the plate so that the capillary ends are immersed in CE Grade Water.

9. Examine the coolant level on the front panel. If required, add coolant into the fill port on the
system.
Refer to the section: "Add Capillary Cartridge Coolant" in the document: Operator Guide.
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Run the Samples 6
Start the Sequence from the Front Panel
To use the Waters Empower™ software, refer to the section: Start the Sample Set Method.

1. If required, load the cartridge, reagent plates, and sample plates.

2. On the front panel, touch RUN SEQUENCE.

Figure 6-1 RUN SEQUENCE Button

3. In the Projects pane, touch CE-SDS Project.

4. In the Available Sequences pane, touch the appropriate sequence in the list.

• For reduced samples, click CE-SDS Test Sequence.

• For non-reduced samples, click Non Reduced CE-SDS Sequence.

• For samples prepared with a low pH sample buffer, click Low pH Sample Buffer CE-
SDS Sequence.

5. (Optional) To view the details of the method, sample plates, or reagent plates, touch
anywhere in the Method column.
To hide the details, touch the column or box again.

6. Touch Run Sequence.

Figure 6-2 Run Sequence Button

Run Sequence is not enabled if the sequence contains a method that is incompatible with
the system configuration.

The data files are saved at the location specified in the sequence.
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If an error occurs during a run and an error recovery method is present in the sequence,
then the BioPhase 8800 system starts the error recovery method.

During the run, various actions are available. Refer to the section: Monitor the Run on the
BioPhase 8800 Front Panel.

When the run is complete, the Run Completed dialog opens.

Figure 6-3 Run Completed Dialog

7. Touch OK to close the Run Completed dialog.

8. As required, store the cartridge. Refer to the section: Store the Cartridge After the Run.

Monitor the Run on the BioPhase 8800 Front
Panel
Use this procedure to monitor the sequence progress, and then, if required, pause or stop the
sequence.

To use the Waters Empower™ software, refer to the section: Monitor the Run in the Waters
Empower™ Software.

Note: The sequence shown in the following figures is for the purpose of illustration. It does not
show a sequence for the CE-SDS Protein Analysis Kit.

1. Monitor the traces for the detector and the current to make sure that the sequence is
running.

2. If a problem is detected, then touch  to stop the run, and then, in the Warning dialog,
touch one of the following:

• Yes: Touch to start the error recovery method, if one is assigned.

• No: Touch if an error recovery method is not assigned.

Note: Stopping the run might result in loss of sample or reagent and damage to the
cartridge.
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• To continue the run, touch Cancel.

Figure 6-4 Warning Dialog

CAUTION: Potential System Damage. If the run is stopped and will not be resumed,
then use the shutdown method to rinse the capillaries before storing the cartridge. If
the capillaries are not rinsed, electrolyte salt crystals or precipitate can accumulate
and might cause plugged capillaries, improper pressure sealing, errors when
injecting samples, arcing, or current leakage.

CAUTION: Potential System Damage. Before starting the run again, make sure to
empty or replace the outlet plate to prevent overflow of reagent and possible damage
to the instrument.

CAUTION: Potential Wrong Result. Before starting the run again, prepare new reagent
plates. If the run has been stopped, then there might not be enough reagents
available to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, then before starting the run again, discard them. The samples
might have degraded.

3. If an error occurs, then touch OK in the error dialog that is shown.
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Figure 6-5 Run Sequence Error

Note: The shows an error at the Rinse action. The grey shading in the row above the
Rinse action indicates that the action is in progress or completed.

4. Review the error:

a. Touch  in the Events tab of the front panel log.
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b. Touch Initialize System to reinitialize the system, and then change the system status to
idle.

Figure 6-6 Sequence Error Events Log

5. If required, pause the run by touching Pause Run.
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Figure 6-7 Run Sequence in Progress

6. To continue the run, touch Cancel Pause.
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Figure 6-8 Restart the Run Sequence

7. To view the data while it is being acquired, touch  in the ribbon.

Note: The data in the following figure is for the purposes of illustration. It does not show
results for samples prepared with the CE-SDS Protein Analysis Kit.
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Figure 6-9 Capillary View

8. (Optional) To zoom in on the data, do the following:

a. Touch Overlay.

b. Use two fingers to zoom in or out to view the electropherogram.

c. Use the hand icon to move the electropherogram.

Note: The zoom feature only works with the overlay view for detector and current.
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Figure 6-10 Zoom In or Out

9. Make sure that the message, Sequence run Completed Successfully, is shown
when the run completes. In the dialog, touch OK.

Figure 6-11 Run Completed
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Waste Disposal
WARNING! Biohazard or Toxic Chemical Hazard. Follow local directives to
dispose of chemicals, cartridges, reagent plates, sample plates, and the
remains of the prepared samples. They might contain regulated compounds
and biohazardous agents.

Store the Cartridge After the Run
WARNING! Puncture Hazard. Be careful when handling the cartridge. The tips of
the capillaries are extremely sharp.

Store the Cartridge for Less than Three Days
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method to clean the capillary.
The shutdown method fills the capillaries with CE-SDS Gel Buffer.

2. Store the cartridge for up to three days in the system with the capillary ends immersed in CE
Grade Water.

Note: If the cartridge has not been used for three hours or longer, then run the conditioning
method before doing a separation.

Store the Cartridge for More than Three Days
1. If the sequence or sample set method does not include the shutdown method, then use the

shutdown method to clean the capillary.
The shutdown method fills the capillaries with CE-SDS Gel Buffer.

2. Rinse the capillary for 10 min at 80 psi with CE Grade Water to clean it.

3. On the ribbon on the BioPhase 8800 system front panel, touch  (Loaded) and
then wait for about one minute.
Waiting lets the coolant return to the coolant reservoir before the cartridge is removed.

4. Remove the cartridge from the system, and then store it upright in the cartridge box at 2 °C
to 8 °C with the capillary ends immersed in CE Grade Water.

Note: Replace the CE Grade Water in the tray regularly to avoid microbial growth in the tray.

Prepare the Cartridge After Storage
• If the cartridge has not been used for more than a day, or if it has been stored for an extended

time, then use the CE-SDS Conditioning method to condition the capillary.
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Note: To prevent arcing, and before installing the cartridge in the system, carefully wipe off any
water from around the electrodes and cartridge body.

Run the Samples

CE-SDS Protein Analysis Kit For the BioPhase 8800
System
38/90

Application Guide
RUO-IDV-05-8662-D



Analyze the Data 7
Analyze the Data with an Analysis Parameters
File
Note: If the Waters Empower™ software will be used to acquire the data, then this procedure
does not apply.

The following instructions explain how to analyze data with the BioPhase Analysis software with
an analysis parameters file. An analysis parameters file contains all of the information required
to integrate the peaks and identify peaks in the data.

Note: This procedure assumes familiarity with the BioPhase software. For detailed instructions,
refer to the document: Software Help System.

Note: The analysis parameters file in this procedure is an example. The parameters might not
be optimal for all data files.

1. On the Home page of the BioPhase software, click Data Analysis.
The BioPhase Analysis software main window opens.

2. Click File > Open, select the data files to analyze, and then click Open.

3. In the Project toolbar, click , navigate to CE-SDS Reduced IgG Analysis, and then click
Open.
The CE-SDS Reduced IgG Analysis file is a starting point for the analysis.

4. Right-click , and then select Apply & Analyze (all).

The software applies all of the parameters in the Integration, Library, and Post Analysis tabs
to all of the data files, and then shows the results.

In the Files pane, the file name is shown in red to indicate that the data has been analyzed.
The number of peaks identified is shown in the Peaks column.

In the Data pane, the analysis results are shown in the table below the graph. At the top
of the table, RMS Noise, P-P Noise, and Drift are shown. In the graph, the baseline is
shown in red and the threshold is shown as a grey horizontal line. Any peaks identified in
the analysis have a blue marker at the peak start, a red marker at the peal apex, and a
green marker at the peak end.

Peaks in the graph are shaded as follows:
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• Green: The peak corresponds to a peak in the Marker Table on the Library tab.

• Blue: The peak corresponds to a peak in the Peak Table on the Library tab.

• Red: The peak is not a named peak.

Refer to the section: Examine the Results.

5. Show the peak names on the graph.

a. Right-click .
The Information Setup dialog opens.

b. Select Name and any other information to view on the graph, such as MT, and then
click OK.

c. Click .

The peak names are shown on the graph. Refer to the section: Examine the Results.

The names are part of the analysis parameters file. To use different names, refer to the
section "Identify the Peaks" in the document: Software Help System.

6. Click in the Files pane below the list of files, and then press the Up and Down arrow keys to
view the data for each file in the Data pane.
If required, drag over a region on the graph to zoom in to see the details of the identified
peaks in that region.

Tip! To prevent having to zoom in on each data file, click  to apply the same zoom
settings to all of the data files.

7. Make sure that the integration is satisfactory. Adjust the integration parameters, and then
analyze the data again as required.

8. Examine the electropherogram for the peaks in the Marker Table and the Peak Table.

a. For each peak in the Marker Table and the Peak Table, make sure that the correct peak
is labeled in the graph.

b. As required, adjust MT in the Marker Table and MT (or Cal MT) in the Peak Table.

c. As required, adjust Tol and Crit, and then click .

• Tol is the tolerance for matching a peak in the graph to a peak in the Marker Table or
the Peak Table. Type % to use the tolerance as a percentage.

• Crit is the peak characteristic to be matched.

• Ctr: The peak closest to the center of the range is matched.

• Ht: The tallest peak in the range is matched.
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• Area: The largest peak in the range is matched.

d. When the peak assignments are satisfactory, right-click , and then select Apply &
Analyze (all).

The software applies the changes to all of the data files.

9. (Optional) In the Project toolbar, click , type a name, select a location, and then click
OK.
The analysis parameters are saved to a file for later use.

10. (Optional) In the File toolbar, right-click , and then select Print (all).
The contents of the Data pane are printed in the current report template. For instructions to
create a report template, refer to the section "Configure a Report" in the document: Operator
Guide.

11. In the File toolbar, right-click , and then select Save (all).
All changes to the results, including the analysis parameters, are saved to the data files.

12. In the File toolbar, right-click , and then select Close (all).
All of the data files close.

Examine the Results
Figure 7-1 Non-reduced IgG Sample in SDS-MW Sample Buffer
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Figure 7-2 Reduced IgG Sample in SDS-MW Sample Buffer

Figure 7-3 NIST IgG Sample in Low pH SDS Sample Buffer
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Figure 7-4 MW Size Standard in SDS-MW Sample Buffer

Review the Results on the Overlay Tab
The Overlay tab shows the graphs for the selected data files. This tab contains the statistics for
the selected data files, as well as the system suitability report.

Note: This section does not describe the system suitability function. For information about
system suitability, refer to the document: Operator Guide.

1. Open a set of data files and the appropriate analysis parameters file, and then analyze the
data. If required, adjust the analysis parameters until the results are satisfactory.

2. In the Files pane, click , and then open the Overlay tab.
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Figure 7-5 Overlay Tab

The color of the trace in the graph corresponds to the color in the circle next to the file name
in the Files pane.

The thicker line is the trace that corresponds to the file selected in the Files pane.

3. Move the slider on the right side of the graph up or down to adjust the traces.

Note: To view the traces as a series of tiled graphs, move the slider all of the way to the top.

4. Calculate the results for all of the files on the Overlay tab.

Figure 7-6 Results Table
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Item Description

1 Reference file

2 Type of analysis

3 Save the results to a comma-separated file

a. Click the list on the right side of the Results Table header to select the type of analysis.

These options are available:

• Reference - All: In the Results Table, show statistics for every peak in the reference
file that is present in all of the other data files.

• Reference - Peak Table: In the Results Table, show statistics for every named peak
in the reference file that is present in all of the other data files.

• Named Peaks: In the Results Table, show statistics for all of the named peaks in any
of the data files.

• All Data (not displayed): Calculate but do not show statistics for all of the peaks in
all of the data files.

• System Suitability: If system suitability was enabled when the data was analyzed,
then show the system suitability report.

A peak in a data file is considered to be matched to a peak in the reference file if the
migration times of the peak apexes match within 5%.

b. Click the list on the left, and then select the reference file.

The reference file is the file against which all of the other files are compared.

Only the Reference - All and Reference - Peak Table analyses use a reference file.

The Results Table updates to show the selected analysis or the system suitability report.

If All Data (not displayed) is selected, then the Results Table is empty. To view the results,
click Save to save the results to a comma-separated file, and then open the file in another
program.

5. (Optional) Repeat step 4 to use a different reference file or view a different type of analysis.

6. (Optional) Click Save.
The Results Table is saved to a comma-separated text file. Only the columns that are shown
in the table are saved.

Note: To save the system suitability results, click File > Save Report. The results are saved
as a PDF.

7. (Optional) Click File > Print.
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The contents of the Overlay tab are printed in the current report template.

8. (Optional) In the File toolbar, right-click , and then select Save (all).
All changes to the results and the analysis parameters are saved to the data files.

9. In the File toolbar, right-click , and then select Close (all).
All of the data files close.

Guidance for Developing Acceptance Criteria
Acceptance criteria that are created for use with this kit for SOPs or other purposes should be
based on parameters inherent to the quality of the separation and attributes that reflect critical
sample qualities. Differences between gel and capillary lots and different systems might lead to
variation in absolute migration times.

Peak purity (as corrected area % of peak), peak resolution, and relative migration time (with the
10 kDa Internal Standard from SCIEX or the main peak in the sample as a reference marker) are
commonly accepted system suitability criteria for CE-SDS analysis. SCIEX strongly discourages
the use of absolute migration time as an acceptance criterion.

Use the MW Size Standard to Estimate Molecular
Weight
To estimate the molecular weight of an unknown protein, use the X-axis external marker
calibration feature. Refer to the section: Create a Calibration Curve Using External Markers.

Note: If the 10 kDa Internal Standard is present in the unknown sample, then use the 10 kDa
Internal Standard as a reference peak to correct for variations in the migration time and to
increase the accuracy of the estimated molecular weight.

1. Do a run with the MW Size Standard.

2. In the BioPhase Analysis software, use the migration times and molecular weights of the
MW Size Standard to create a calibration curve.

3. Apply the calibration curve to the data. The estimated molecular weight of the unknown
protein is shown as Cal MT in the Results Table and in the annotations on the graph, if
shown.

SCIEX recommends that the external calibration curve be calibrated again after 24 runs. To
calibrate the curve again, do another run with the MW Size Standard, and then update the
migration time for each standard with the results of the run.

Analyze the Data

CE-SDS Protein Analysis Kit For the BioPhase 8800
System
46/90

Application Guide
RUO-IDV-05-8662-D



Create a Calibration Curve Using External Markers
Use this function to generate the calibration curve for the X-axis from a set of external markers.
If a reference marker is present in both the external marker set and the unknown sample, then
the reference marker can be used to correct for variation in migration time.

1. Set the parameters for the calibration curve.

a. Open the data file that contains the results from the separation of the standards.

b. Integrate the data.

c. In the Marker Table, assign the peaks for the MW Size Standard as markers.

d. For each marker, type the molecular weight in the corresponding Cal MT cell.

e. Select External markers, above the Marker Table on the right side of the tab.

f. Type the X-axis Name and the Units.

g. In the Fit Type list, select the type of calibration curve.

2. (Optional) Set the parameters for matching a reference peak to a peak in the data for the
sample containing the unknown.

a. Select Ref in the Marker Table for the reference peak.

b. Click .

c. In the Ref MT field, type the expected migration time of the reference peak in the data
for the sample containing the unknown.

d. In the Tol field, type the tolerance.

e. In the Crit list, select the criteria.

f. Click OK.

If a reference peak is selected, then the migration times in the calibration curve are
corrected by multiplying the migration time by the ratio of the Ref Peak MT (unknown)
and Ref Peak MT (external marker set). This results in a more accurate determination of
Cal MT, despite variations in migration time.

3. Click , and then examine the graph and the Results Table to make sure that the Cal MT
values are correct.

4. Click Show Graph, and then make sure that the data points from the Marker Table fit the
calibration curve.
The calibration curve is based on the MT and Cal MT values in the Marker Table.

5. Click , and then save the parameters to an analysis parameters (dana) file.

6. Click File > Open, and then select the files to be analyzed.
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7. Open the analysis parameters file created in step 5.

8. Right-click , and then select Apply & Analyze (all) or Apply & Analyze (checked).
If the reference peak is present in both the external marker set and the unknown data,
then examine the results. If required, click , and then adjust the Ref MT, Tol and Crit
values in the dialog so that the reference peak in the unknown is found in the migration time
window.
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Run the Samples with the Waters
Empower™ Software 8
This section gives instructions for the use of the Waters Empower™ software and the BioPhase
8800 driver for Empower™ with the BioPhase 8800 system.

Import the BioPhase Software Methods to Create
the Instrument Methods
Note: Methods created with the BioPhase software are supplied with the BioPhase 8800 driver
for Empower™. The methods are also available for download from the SCIEX web site. Refer to
the section: Download and Configure the Required Files (Waters Empower™ Software).

Instrument methods can also be created in the Method Editors for BioPhase System software.
Refer to the documents: Operator Guide and Software Help System.

Typically, three types of methods are required: a conditioning method, a separation method, and
a shutdown method. For some workflows, there are additional methods.

The following methods are available.

• CE-SDS Conditioning: Conditions the capillaries.

• Separation methods:

• Reduced CE-SDS Separation: For reduced samples.

• Non Reduced CE-SDS Separation: For non-reduced samples.

• Low pH Sample Buffer Separation: For samples prepared with a low pH sample buffer.

• CE-SDS Shutdown: Cleans the capillaries at the end of a sequence, rinses the capillaries for
storage, and then turns off the lamp.

Use the following steps to import the BioPhase software methods and create instrument
methods and method sets to be used with the Waters Empower™ software. Create the
appropriate methods and method sets for the workkflow.

1. In the Waters Empower™ Software Project window, click File > New Method > Instrument
Method.
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Figure 8-1 Select Desired Chromatography System Dialog

2. Click the system to be used, and then click OK.

The Instrument Method Editor opens.

3. Click Import, and then browse to the conditioning method.
The method opens in the Instrument Method Editor window with the Method Settings tab in
front.

Note: This window is read-only. If changes to the method are required, then save the
instrument method, and then edit the method in the Method Editors for BioPhase System
software. Refer to the section: "Edit an Existing Instrument Method" in the document:
Software Help.
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Figure 8-2 Method Settings Tab in the Instrument Method Editor

4. (Optional) Open the Method Program tab to see the actions.

5. To see the parameters for an action, click the row in the table.
The Parameters pane updates to show the parameters.
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Figure 8-3 Method Program Tab in the Instrument Method Editor

6. Save the conditioning instrument method.

a. Click File > Save with Method Set.
The Save current Instrument Method dialog opens.

b. In the Name field, type a name.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Although some versions
of the Waters Empower™ software accept more than 30 characters and other special
characters, if the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.

c. (Optional) In the Method Comments field, type the information.

d. If prompted, in the Password field, type the Waters Empower™ software password for
the current user, and then click Save.

The instrument method and method set are saved to the current project.

7. Click File > Exit.

Note: After a method has been imported, the Import button in the Instrument Method Editor
window is not available unless the window is closed and then opened.

8. Repeat steps 3 through 7 to create the other instrument methods and method sets.
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Create the Sample Set Method
The following instructions create a sample set method for eight samples, the number of wells in
one column in a sample plate.

Note: A sample set method requires method sets. Make sure that any required instrument
method is part of a method set.

1. In the Waters Empower™ Software Run Samples window, click BioPhase 8800 > BioPhase
Sample Set Editor.

The Method Editors for BioPhase System software opens, with the Sample Set Method
Editor workspace shown.

2. Click New Sample Set Method.
The Sample Set Method Editor opens with the Sample Plate Setup tab shown.

3. In first row of the Sample Set Summary table, click the Method Set Name cell, and then
select CE-SDS Conditioning.

4. In the Sample Plate Layout pane, click 1.
The first column in the sample plate is selected and the Sample Set Summary table updates
to show the selected wells.

Figure 8-4 Sample Plate Layout Pane
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5. Add the required sample information to the Sample Set Summary table. In rows 2 through 9,
do the following:

a. In the Sample Name cell, type a name for the sample.

b. Click the Method Set Name cell, and then select Reduced CE-SDS Separation or the
appropriate separation method from the list.

Tip! After selecting the method set for row 2, right-click and select Apply method to all
samples in column to assign the method to all of the samples.

6. In the last row, click the Method Set Name cell, and then select CE-SDS Shutdown.

Figure 8-5 Sample Set Summary Table

7. If the Validation pane is shown, then click the pane to see the errors. Click an error to
highlight the location where it occurs, and then make the required change.
If no errors are present, then the Validation pane is not shown.

8. Save the sample set method.

a. Click SAVE AS.

Note: The SAVE AS button is not available if there are errors. Resolve all of the errors
in the Validation pane, and then click SAVE AS.

The Save Sample Set dialog opens.

b. Type a name in the Sample Set Name field.

Note: The name must be less than 30 characters and can contain alphanumeric
characters, spaces, and the special characters @, _, and %. Although some versions
of the Waters Empower™ software accept more than 30 characters and other special
characters, if the method is edited in the Method Editors for BioPhase System software,
then those characters might cause issues.
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c. (Optional) Type information in the Description field.

d. Click Save, and then click OK to acknowledge the saved method.

The sample set method is saved to the Waters Empower™ software database.

9. To see, save, or print the plate layouts:

a. Open the Plate Layouts tab.

b. (Optional) Click PRINT.
The Print Preview window opens.

c. As required, click the buttons to print or save the plate layouts.
Refer to the section: "Print Preview Dialog" in the document: Software Help System.

d. Click the close box, the × in the top right corner.
The Print Preview dialog closes.

10. In the Method Editors for BioPhase System window, click the close box, the × in the top right
corner.
The Method Editors for BioPhase System software closes and the Run Samples window is
shown.

Start the Sample Set Method
1. Load the cartridge and the plates. Refer to the section: Prepare the BioPhase 8800 System.

2. In the Waters Empower™ software Project window, click Tools > Run Samples.

Figure 8-6 Select Desired Chromatography System Dialog

3. Click the system to be used, and then click OK.
The Run Samples window opens.
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4. Configure the plate type.

a. Click Edit > Plates.

Figure 8-7 Define Plates for Sample Set Method Dialog

Note: If the dialog does not look like the preceding figure, then clear the 2790 Layout
check box.

b. Click the Plate Type Name cell, and then select ANSI-96well2mL.
The dialog updates with an image of the plate and buttons for the plate sequencing
mode.

c. Click the Plate Layout Position cell, and then type 1.

d. Click  to indicate the order that the wells are accessed during the run.

e. Click OK to save the changes, and then close the dialog.

Tip! To permanently configure the plate type, click Customize > Defaults, click Plates, do
steps 4.b through 4.e, and then click OK.

In the Sample Set Method table, the heading for the Vials column changes to Plate/Well.

5. Click  (Load Sample Set).

Run the Samples with the Waters Empower™ Software

CE-SDS Protein Analysis Kit For the BioPhase 8800
System
56/90

Application Guide
RUO-IDV-05-8662-D



Figure 8-8 Load Samples Dialog

6. Click Load using a previously created sample set method, and then click OK.

Figure 8-9 Open an existing sample set method Dialog

7. Click CE-SDS Kit Sample Set Method in the list, and then click Open.
The sample set method opens in the Samples tab.

8. (Optional) Configure the table to show only the columns that are relevant for the BioPhase
8800 system.
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a. Right-click, and then select Table Properties.
The Table Properties dialog opens.

b. Click Hide All, and then clear the check boxes for Plate/Well, # of Injs, SampleName,
Function, and Method Set / Report or Export Method.

c. Click OK.

The table updates to show the selected columns.

Figure 8-10 Samples Tab

9. Review the sample set method. Make sure that the correct reagent plate layout was used. If
any changes are required, then edit the method in the Method Editors for BioPhase System
software. Any changes to the instrument methods or method sets automatically propagate
to the sample set method.

10. In the Waters Empower™ Software Project window, click  (Start).
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Figure 8-11 Run Sample Set Dialog

11. If required, edit the information in the Run Sample Set dialog.

a. If required, edit the Name for this sample set field.

b. (Optional) Click Shutdown Method, and then select an instrument method that rinses
the capillaries.
If available, use a SCIEX-provided rinse method. If a rinse method is not available,
then create one. Use the same reagent set as the sample set method and the following
parameters:

• Pressure: 50 psi

• Duration: 2 min

• Inlet: Water

• Outlet: Waste

If the system encounters an error during a run, then it executes this instrument method,
and then stops the run.
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c. If required, select Do Not Run Shutdown Method During User Abort.

d. Click Run.

The run starts. During the run, the text in the row in the Sample Set Method window for the
sample being acquired is red.

CAUTION: Potential Data Loss. Do not initiate any actions from the BioPhase 8800
driver for Empower™ Direct Control pane during a run, even if the system status is
idle. Any actions might interfere with data acquisition.

Monitor the Run in the Waters Empower™

Software
Use this procedure to monitor the progress of the sample set method, and then, if required,
pause or stop it.

Note: Most of the panes in the Waters Empower™ software are designed for chromatography.
Use the following steps to monitor the progress of the capillary electrophoresis separation and
disregard information in the Time Remaining and Solvent Required panes.

1. If a problem is detected, to stop the run, click  (Abort).

CAUTION: Potential Data Loss. Do not stop the run until all of the data is saved. The
data is saved when the sample set method is on the next row.

Note: Do not use the Stop button in the Direct Control pane. That button only operates on
functions initiated from the Direct Control pane.
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Figure 8-12 Abort Options Dialog

CAUTION: Potential System Damage. If the run is stopped and will not be resumed,
then use the shutdown method to rinse the capillaries before storing the cartridge. If
the capillaries are not rinsed, electrolyte salt crystals or precipitate can accumulate
and might cause plugged capillaries, improper pressure sealing, errors when
injecting samples, arcing, or current leakage.

CAUTION: Potential System Damage. Before starting the run again, make sure to
empty or replace the outlet plate to prevent overflow of reagent and possible damage
to the instrument.

CAUTION: Potential Wrong Result. Before starting the run again, prepare new reagent
plates. If the run has been stopped, then there might not be enough reagents
available to complete the run.

CAUTION: Potential Wrong Result. If the samples have been inside of the system for
more than 24 hours, then before starting the run again, discard them. The samples
might have degraded.

When the run ends, the text in all of the rows in the Sample Set Method window is red.

2. To view the data while it is acquired, in the Direct Control pane, click  (Monitor).
The Trace View window opens, and then the data is shown.
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Figure 8-13 Trace View Window

3. If required, do any of the following:

• To view current, voltage, or pressure, open the applicable tab in the top left.

• To view one graph with the data for all of the capillaries, in the bottom left click Overlay.

• To view data for specific capillaries, select or clear the check boxes at the bottom of the
window to select the capillaries of interest.

• To view the time and detector values for any point on a trace, click the trace at the
position of interest.

• To zoom in on the data, make sure that Overlay is selected, and then drag to select the
area to zoom. The mouse scroll wheel can also be used to zoom.

• To return the data to the original dimensions, in the bottom right click Reset Zoom.

• To view a different area of a zoomed plot, right-click the X- or Y-axis and then drag.

4. If required, at the bottom right click Auto Zero.
The detector signal is set to zero.

5. Wait until the Abort button ( ) changes from red to green ( ).
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There might be a delay between data acquisition and when all of the data is saved. The
green button indicates when all of the data is saved.

6. As required, dispose of samples and reagents. Refer to the section: Waste Disposal.

7. As required, store the cartridge. Refer to the section: Store the Cartridge After the Run.
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Troubleshooting 9
After each corrective action is complete, we recommend doing the analysis again to make sure
that the symptom has been corrected.

Symptom Possible Cause Corrective Action

Cartridge not
detected error

1. The ID chip on the cartridge is
not clean.

2. The contact pins on the
system are not clean.

3. The BioPhase 8800 system
firmware is not up to date.

1. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
wipe the surface of the ID chip.
Let the ID chip air dry before
installing the cartridge.

2. Moisten a lint-free laboratory
wipe or cotton swab with
ethanol or isopropanol, and then
wipe the contact pins. Let the
pins air dry before installing the
cartridge.

3. Do the following:

a. On the BioPhase 8800
system front panel, touch
the icon in the upper left
corner.

b. Record the firmware
version.

c. Contact sciex.com/request-
support.
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Symptom Possible Cause Corrective Action

Error encountered
at beginning of run

1. The optical scan at the
beginning of the run failed
because of condensation on
the cartridge window.

2. Opening and closing the
optics door caused a sensor
error.

1. In the shutdown method,
increase the Sample Storage
temperature to 20 °C to prevent
condensation.

2. Turn off, and then turn on the
BioPhase 8800 system. Make
sure to follow the procedure to
change UV filters and do not
open the optics door except as
instructed. Refer to the section:
"Install a UV Filter" in the
document: Operator Guide.
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Symptom Possible Cause Corrective Action

Broad peaks, poor
resolution

1. The capillary end is damaged.

2. The sample concentration is
too high.

3. The capillary is blocked.

4. The internal surface of the
capillary is contaminated.

1. To assess the condition of the
capillary end:

• Use a magnifying lens to
examine it.

• Use a lint-free laboratory
wipe to wipe the capillary
inlets carefully in an outward
direction.

• Make sure that the capillary
end extends approximately
2 mm from the gold cannula
electrode.

• Make sure that the capillary
end has a straight cut. If
the capillary cannot be used,
then refer to the section:
Options for a Blocked or
Damaged Capillary.

2. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

3. Refer to the section: Options
for a Blocked or Damaged
Capillary.

4. Either edit the sequence to omit
the contaminated capillary or
replace the cartridge.
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Symptom Possible Cause Corrective Action

Carryover 1. The sample concentration is
too high.

2. The reagent plate is
contaminated with sample.

1. Do one or all of the following:

• Decrease the Duration in
the Inject action in the
separation method to inject
less sample. If the results
are not satisfactory, then
decrease the Pressure or
Voltage.

• Dilute the sample again with
the sample diluent.

2. In the separation method, add
one or more water dip steps
after sample injection. With the
edited method:

a. Create a new sequence
that uses this separation
method.

b. Prepare new reagent plates
for the new sequence.
Refer to the section: Load
the Reagent Inlet and
Outlet Plates.

High current 1. The gel buffer is
contaminated.

2. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

1. Prepare the inlet and outlet
reagent plates again to replace
the gel buffer.

2. Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are not
correct, then prepare the plates
again according to the plate
layout. Refer to the section:
Plate Layouts.

Troubleshooting

Application Guide
RUO-IDV-05-8662-D

CE-SDS Protein Analysis Kit For the BioPhase 8800
System

67/90



Symptom Possible Cause Corrective Action

Low or unsteady
current

1. The capillary end is blocked
or contaminated.

2. The gel buffer has air
bubbles.

1. Refer to the section: Remove
Blockage from a Capillary. If the
current is low or unsteady, then
replace the cartridge.

2. Do one or all of the following:

• Use a centrifuge to spin the
plate for 5 min at 30 g to
remove air bubbles.

• De-gas the gel buffer for
5 min with 5 inches Hg to
15 inches Hg vacuum.

Missing peaks in
electropherogram
sample

1. A pipetting error occurred
during preparation of the
sample.

2. The method parameters are
incorrect.

3. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

1. Prepare a new sample.

2. Do the following:

• In Method Settings, make
sure that the value for
Detector Type is correct.

• In the separation method,
make sure that the values
for Type of Injection and
Duration are correct.

• In the separation method,
make sure that the value for
Wavelength is 220 nm.

3. Make sure that the positions of
the samples in the sample plate
agree with the plate layouts. If
the positions are not correct,
then prepare the plates again
according to the plate layout.
Refer to the section: Reagents,
Plate Layouts, and Methods.
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Symptom Possible Cause Corrective Action

No electrical current
during separation

1. The capillary is damaged.

2. The electrode is broken or
bent.

3. The capillary end is blocked
or contaminated.

4. The positions of the reagents
in the reagent plate do not
agree with the plate layouts in
the sequence.

5. A capillary is filled with air
bubbles.

1. Refer to the section: Options
for a Blocked or Damaged
Capillary.

2. Replace the cartridge.

3. Refer to the section: Remove
Blockage from a Capillary.

4. Make sure that the positions
of the samples and reagents
in the plates agree with the
plate layouts. If the positions
are not correct, then prepare
the plates again according to
the plate layout. Refer to the
section: Plate Layouts.

5. Do one or all of the following:

• Make sure that the wells
of the sample and reagent
plates contain sufficient
solution.

• Make sure that the positions
of the reagents in the reagent
plates agree with the plate
layouts. If the positions are
not correct, then prepare the
plates again according to the
plate layout. Refer to the
section: Plate Layouts.

• Use a centrifuge to spin the
plate for 5 min at 30 g to
remove air bubbles.
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Symptom Possible Cause Corrective Action

No peaks 1. The lifetime of the UV lamp
has been exceeded.

2. The method parameters are
incorrect.

3. Air bubbles in a sample well
prevent sample injection.

4. The capillary window is
blocked.

5. The capillary end is blocked
or contaminated.

6. The sample volume is too low.

7. There is no sample in a
sample well, or the position
of the samples in the sample
plate do not agree with the
plate layouts in the sequence.

1. Refer to the section: "Install a
UV Lamp" in the document:
Operator Guide.

2. Do the following:

• In Method Settings, make
sure that the value for
Detector Type is UV.

• In the Inject and Separate
actions, make sure that
the value for Polarity is
Reverse.

• In the separation method,
make sure that the value for
Wavelength is 220 nm.

• Make sure that pressure is
applied at the inlet and the
outlet during the separation.

3. Use a centrifuge to spin the
plate for 5 min at 30 g to remove
air bubbles.

4. Examine the capillary window.
Make sure that the window is
clean and the path is clear.
Refer to the section: Examine
the Capillary Cartridge.

5. Refer to the section: Options
for a Blocked or Damaged
Capillary. Condition the
capillary. Refer to the section:
Condition the Capillaries.

6. Make sure that there is 100 µL
of sample in the sample well.

7. Make sure that the position of
the samples in the sample plate
agrees with the plate layout.
Refer to the section: Plate
Layouts.
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Symptom Possible Cause Corrective Action

Spikes in
electropherogram

1. The gel buffer has air
bubbles.

1. Do one or all of the following:

• Use a centrifuge to spin the
plate for 5 min at 30 g to
remove air bubbles.

• De-gas the gel buffer for
5 min with 5 inches Hg to
15 inches Hg vacuum.

Remove Blockage from a Capillary
1. Rinse the capillary with CE Grade Water for 10 min at 75 psi.

2. Use CE Grade Water to clean the capillary inlets.

3. Use a lint-free laboratory wipe to wipe the capillary inlets carefully in an outward direction.

4. To assess the condition of the capillary, do the following:

a. Use Direct Control to fill the capillary with separation gel.

b. Put the inlet and outlet capillaries in the separation buffer in the reagent tray.

c. Apply the separation voltage and monitor the stability of the current.

5. If the blockage cannot be removed, then either edit the sequence to omit the damaged
capillary or replace the cartridge.

Options for a Blocked or Damaged Capillary
If blockage in a capillary cannot be removed or a capillary is damaged, then edit the sequence to
omit the blocked or damaged capillary. Refer to the section: Create the Sequence.

Condition the Capillaries
• If required, condition the capillaries using the CE-SDS Conditioning method.
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Hazardous Substance Information A
The following information must be noted and the relevant safety measures taken. Refer to the
respective safety data sheets for more information. The safety data sheets are available upon
request or can be downloaded from our website, at sciex.com/tech-regulatory.

Hazard classification according to HCS 2012.

Acid Wash/Regenerating Solution (0.1 M HCl)

DANGER! Causes severe skin burns and eye damage.

Capillary Regenerator Solution A Basic Wash (0.1 M NaOH)

DANGER! Causes severe skin burns and eye damage.

CE-SDS Gel Buffer, pH 8, 0.2% SDS

DANGER! Causes mild skin irritation. May damage fertility of the unborn child.

IgG Control Standard

WARNING! Causes mild skin irritation.

Low pH SDS Sample Buffer (100 mM Tris-HCL, pH 6.8, 1% SDS)

WARNING! Causes mild skin irritation.

Other Reagents

These components are not classified as hazardous:

• CE Grade Water

• MW Size Standard

• SDS-MW Sample Buffer

Hazardous Substance Information
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• 10 kDa Internal Standard

For reagents from other vendors, read the safety data sheet from the vendor before use.
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Download Required Files C
Depending on the software in use, the steps are different.

• BioPhase software users, refer to the section: Download and Configure the Required Files
(BioPhase Software).

• Waters Empower™ software users, refer to the section: Download and Configure the Required
Files (Waters Empower™ Software).

Download and Configure the Required Files
(BioPhase Software)
Files with methods, sequences, reagents, and analysis parameters for the CE-SDS Protein
Analysis Kit are available on sciex.com. Use the following instructions to download the files, and
then copy them to the appropriate location.

Note: The following procedure is only required when BioPhase software version 1.1 is being
used. The required files for the CE-SDS Protein Analysis Kit are included as part of the
BioPhase software version 1.2 or later.

1. Go to sciex.com/software-support/software-downloads, and then click BioPhase
Resources in the More software downloads section.

2. Click BioPhase Project Files 1.2.

3. In File Explorer, right-click the BioPhase_1.2.zip file, and then click Extract All to
extract the installation package.

4. Browse to a location, click Select Folder, and then click Extract.
The extracted files are copied to the selected file path.

5. Put the extracted files in the correct locations. Do the following:

Note: The following instructions assume that the BioPhase software project folders are
located in the default location: C:\Biophase. If the project folders are in a different
location, then put the extracted files in that location.

a. Drag the BioPhase_1.2\Projects\CE-SDS folder to C:\BioPhase\Projects.

b. Drag the BioPhase_1.2\Reagents\CE-SDS folder to C:\BioPhase\Reagents.

c. Drag the BioPhase_1.2\Data Analysis\CE-SDS folder to C:\BioPhase\Data
Analysis.

Download Required Files
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Download and Configure the Required Files
(Waters Empower™ Software)
Required files for the CE-SDS Protein Analysis Kit are available on sciex.com. Use the following
instructions to download the files, and then copy them to the appropriate location.

1. Go to sciex.com/software-support/software-downloads, and then, in the More software
downloads section, click BioPhase Driver Resources.

2. Click BioPhase Method Files 1.3.

3. In File Explorer, right-click the BioPhase-Empower-Method-Files-1.3.zip file, and
then click Extract All.

4. Browse to the location to save the method files, click Select Folder, and then click Extract.
The extracted files are extracted and copied to the specified location.

Download Required Files
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Reagents, Plate Layouts, and
Methods D
Reagent Set
If the reagents are not available, then use the following figures to create a new reagent set.
Refer to the figures: Figure D-1 and Figure D-2.

Figure D-1 CE-SDS Protein Analysis Kit Inlet Reagents

Reagents, Plate Layouts, and Methods
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Figure D-2 CE-SDS Protein Analysis Kit Outlet Reagents

Plate Layouts
Note: The following figures show the plate layouts corresponding to the sequence supplied with
the software. The plate layouts are the same for all of the sequences. If additional samples have
been added or the reagent positions have been edited, then the following layouts are not correct.

Sample Plates

Note: The top row shows the layout for the sample outlet plate. The bottom section shows the
layout for the sample inlet plate.
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Figure D-3 Layouts for the Sample Inlet Plate and Sample Outlet Plate

Reagent Plates

Note: The top row shows the layout for the reagent outlet plate. The bottom section shows the
layout for the reagent inlet plate.
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Figure D-4 Layouts for the Reagent Inlet Plate and Reagent Outlet Plate
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Methods
For instructions for creating a method, refer to the document: Software Help System.

Method Settings
Note: Use these settings for all of the methods.

Figure D-5 Method Settings for CE-SDS Protein Analysis Methods

Conditioning Method
Figure D-6 Actions in the CE-SDS Conditioning Method
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Figure D-7 Summary of Actions in the CE-SDS Conditioning Method

Separation Method for Non-Reduced Samples
Figure D-8 Actions in the Non Reduced CE-SDS Separation Method
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Figure D-9 Summary of Actions in the Non Reduced CE-SDS Separation Method
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Separation Method for Reduced Samples
Figure D-10 Actions in the Reduced CE-SDS Separation Method
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Figure D-11 Summary of Actions in the Reduced CE-SDS Separation Method
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Separation Method for Samples Prepared in a Low pH Sample
Buffer
Figure D-12 Actions in the Low pH Sample Buffer Separation Method
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Figure D-13 Summary of Actions in the Low pH Sample Buffer Separation Method

Shutdown Method
Figure D-14 Actions in the CE-SDS Shutdown Method
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Figure D-15 Summary of Actions in the CE-SDS Shutdown Method
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Contact Us

Customer Training
• In North America: NA.CustomerTraining@sciex.com

• In Europe: Europe.CustomerTraining@sciex.com

• Outside the EU and North America, visit sciex.com/education for contact information.

Online Learning Center
• SCIEX Now Learning Hub

Purchase Supplies and Reagents
Reorder SCIEX supplies and reagents online at store.sciex.com. To set up an order, use the
account number, found on the quote, order confirmation, or shipping documents. Currently,
customers in the United States, United Kingdom, and Germany have access to the online store,
but access will be extended to other countries in the future. For customers in other countries,
contact a local SCIEX representative.

SCIEX Support
SCIEX and its representatives maintain a staff of fully-trained service and technical specialists
located throughout the world. They can answer questions about the system or any technical
issues that might arise. For more information, visit the SCIEX website at sciex.com or contact us
in one of the following ways:

• sciex.com/contact-us

• sciex.com/request-support

CyberSecurity
For the latest guidance on cybersecurity for SCIEX products, visit sciex.com/productsecurity.

Documentation
This version of the document supercedes all previous versions of this document.

To see this document electronically, Adobe Acrobat Reader is required. To download the latest
version, go to https://get.adobe.com/reader.
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To find software product documentation, refer to the release notes or software installation guide
that comes with the software.

To find hardware product documentation, refer to the documentation that comes with the system
or component.

The latest versions of the documentation are available on the SCIEX website, at sciex.com/
customer-documents.

Note: To request a free, printed version of this document, contact sciex.com/contact-us.
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